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It’s fairly clear that modern busi-
ness applications are becoming ever
more complex, ever more distributed,
and ever more vital to users and corpo-
rations. A few years ago, when you
needed to renew the road license on
your car, you drove down to the local of-
fice and stood in a queue. Now you just
go to the appropriate Web site, enter
some details, and apply the plastic
(credit card). So, in England, when the
system died on the first valid renewal
day of April, there were letters in the
newspapers from hundreds of angry
motorists—and it even made the main
evening news broadcast.

Building complex distributed and
componentized applications means you
often come across architectural and de-
sign issues that can soon turn a basic de-
sign into a jumble of shared objects,
unmanageable component references,
and cross-cutting concerns that are
wildly out-of-control; a jungle of inter-
dependent, interacting, and perhaps
even indecipherable connections, 

dependencies,
and references.

So, where do
you go to escape
this? How do
you simplify the
a r c h i t e c t u r e
and design so

that it all fits onto one whiteboard or one
PowerPoint slide? How do you solve the
problem of the whole application de-
pending on some basic component or
service that you don’t dare to change in
case it breaks everything?

You need to bring unity into your life,
and into your applications. And right on
cue—enter stage left—the new Unity
Application Block from Microsoft’s
Patterns & Practices group.  Unity is a
lightweight, extensible dependency in-
jection container with support for con-
structor, property, and method call
injection. It offers:

• Simplified object creation, espe-
cially for hierarchical object structures

ALEX HOMER 
Inject Some Unity into Your Applications

>> Alex Homer

and dependencies, which simplifies
application code. 

• Abstraction of requirements; this
allows developers to specify dependen-
cies at run time or in configuration,
and simplify management of cross-cut-
ting concerns. 

• Flexibility by deferring component
configuration to the container. 

• Service location capability; this al-
lows clients to store or cache the con-
tainer. This is especially useful in
ASP.NET Web applications where the
developers can persist the container in
the ASP.NET session or application.

Of course, dependency injection is not
the only way to solve the issues found in
large and complex business applications.
The much talked about approach to man-
aging cross-cutting concerns today is As-
pect Oriented Programming (AOP), and
there are many solutions available from
third parties, based both on commercial
or open source operating systems and

ASP

Imports Microsoft.Practices.Unity
Imports Microsoft.Practices.Unity.Configuration

using Microsoft.Practices.Unity;
using Microsoft.Practices.Unity.Configuration;

C#

FIGURE 1

Visual Basic

Private myContainer As IUnityContainer = New UnityContainer()

private IUnityContainer myContainer = new UnityContainer();

C#

FIGURE 2

Visual Basic

Inject Some Unity: Continued on pg.53
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platforms. Well-known dependency in-
jection mechanisms are Spring and Cas-
tle, while Microsoft has for some time
offered AOP support through the Policy
Injection Application Block. 

However, Unity is a new fully fledged
and highly usable mechanism for use
with .NET Framework version 2.0 and
higher, and supports development in Vi-
sual Studio 2005 and Visual Studio
2008. And it’s as easy to use as falling
off a log. Or walking and chewing gum

tices.Unity.Configuration into the bin
folder of your application and import
the codes in Figure 1 into your page or
class file.

Now you can create an instance of the
UnityContainer class, holding the ref-
erence in a variable of type IUnityCon-
tainer (see Figure 2).

You can, of course, create multiple
containers, and even nest them to create
a container hierarchy. See the Unity
documentation for more details.

at the same time. Even for men. In fact,
in the next ten minutes you are going to
become an expert in using the Inversion
of Control (IoC) and Dependency Injec-
tion patterns. Well, that’s unless you
skip to the next article now...

CREATE YOUR CONTAINER

Download Unity from the community
Web site at http://www.codeplex.com/
unity/ and install it on your machine.
Then, before you start writing code, 
copy the two assemblies Microsoft.
Practices.Unity and Microsoft.Prac-

<unity>
<typeAliases>

<typeAlias alias="singleton"
type="Microsoft.Practices.Unity.ContainerControlledLifetimeManager,

Microsoft.Practices.Unity" />
<typeAlias alias="IMyInterface"

type="MyObjects.IMyInterface, MyObjects" />
<typeAlias alias="MyRealObject"

type="MyObjects.MyRealObject, MyObjects" />
...

</typeAliases>

<containers>
<container name="containerOne">

<types>
<!-- Default (un-named) mapping for IMyInterface to MyRealObject-->
<type type="IMyInterface" mapTo="MyRealObject" />
<!-- Default (un-named) mapping for ILogger to MyLogger -->
<type type="ILogger" mapTo="MyLogger">

<lifetime type="singleton" />
</type>
...  

</types>
</container>

</containers>
</unity>

FIGURE 3

XML

Inject Some Unity: Continued from pg.52
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Dim section As UnityConfigurationSection _
= CType(ConfigurationManager.GetSection("unity"), 

UnityConfigurationSection)
section.Containers("containerOne").Configure(myContainer)

UnityConfigurationSection section 
= (UnityConfigurationSection)ConfigurationManager.GetSection("unity"); 

section.Containers["containerOne"].Configure(myContainer);

C#

FIGURE 4

Visual Basic

POPULATE YOUR CONTAINER

You can populate your container(s)
using a configuration source, or by sim-
ply executing methods that add type reg-
istrations and mappings to the container.
As an example, for the basic situation
where you just want to specify type map-
pings, the Figure 3 XML configuration
file content will provide the necessary in-
formation (depending on the application
type, this content will be in the file
App.config or Web.config).

Notice that the configuration contains
a section for type aliases, which allows
you to more easily specify types in your
mappings without having to repeat the
full assembly, culture, and public key in-
formation each time.

The <types> section in Figure 3 con-
tains the mappings for a container
named containerOne. These mappings
consist of un-named (default) mappings
for the interface IMyInterface to the
concrete type IMyRealObject, and for
the interface ILogger to the concrete
type MyLogger; plus other mappings
not shown in the listing.

and how you can use lifetime managers
to control the lifetime of object instances,
see the Unity documentation.

RESOLVE OBJECT FROM YOUR 
CONTAINER

One you have a populated Unity con-
tainer, you can use it to resolve instances
of objects. For example, to get an in-
stance of an object that implements the
MyInterface interface based on the
mappings in the container you would use
the code in Figure 6.

If there is no mapping for the type you
request, Unity will simply create and re-
turn an instance of the type you request.
For example, if you ask for an instance of
the MyDifferentObject class (as
shown in the code in Figure 7) and there
are no mappings or registrations in the
container, Unity will just generate a new
instance of the MyDifferentObject
class and return it.

The UnityContainer class also exposes
the ResolveAll method that returns a col-
lection of all mapped objects that use
named mappings (see the following sec-
tion for details). This method does not

To load the configuration into the con-
tainer, you use the standard .NET con-
figuration techniques. The code in Figure
4 shows how you can load the <unity>
section configuration information into
the container named containerOne.  

An alternative approach is to configure
your container(s) using the methods of the
UnityContainer class. These include:

• The RegisterType method that reg-
isters types and mappings between
types, including specifying the lifetime
of the objects (such as a singleton or
externally-controlled). 

• The RegisterInstance method that
registers existing instances of objects,
including specifying the lifetime of the
objects (such as a singleton or exter-
nally-controlled). 

For example, the code in Figure 5 reg-
isters a mapping between the IMyInter-
face interface type and the
MyOtherObject concrete class.

You can register a mapping between
an interface and an object that imple-
ments the interface, or between a base
class and a class that inherits the base
class. For more information on the
methods of the UnityContainer class,

Inject Some Unity: Continued from pg.53
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myContainer.RegisterType(Of IMyInterface, MyOtherObject)()

myContainer.RegisterType<IMyInterface, MyOtherObject>();

C#

FIGURE 5

Visual Basic

Dim myInstance As IMyInterface = myContainer.Resolve(Of IMyInterface)()

IMyInterface myInstance = myContainer.Resolve<MyInterface>();

C#

FIGURE 6

Visual Basic

return objects mapped using default
(un-named) mappings.

LOCATE A SERVICE BY NAME IN 
YOUR CONTAINER

You can register mappings in a con-
tainer with a name, which allows you to
register multiple mappings for the same
type. For example, the following frag-
ment of a Unity configuration file in Fig-
ure 8 creates two mappings for the
ILogger interface. One mapping, named
StandardLogger, maps to the MyLog-
ger class. The other, named Super-
FastLogger, maps to the
MyFastLogger class.   

You can also create named registra-
tions and mappings using the Register-
Type and RegisterInstance methods.
Note that registration and mapping
names are case-sensitive.

Now, when you call the Resolve
method, you just specify the mapping
name. Unity will use the appropriate
mapping to decide which object type to
generate. For example, if the list box
named lst_LoggerType contains the
two string values StandardLogger and

SuperFastLogger, the code in Figure
9 will generate an instance of the type se-
lected in the list box.

This technique is a useful way to locate
services based on simple service names.
For example, you could configure the
service names in your application config-
uration file, or create them at run time,
and then use the Resolve method with
the service name to generate an instance
(or return an existing singleton instance)
of the required service.  

LET YOUR OBJECTS DO THEIR 
OWN INJECTION

Unity provides dependency injection
support for constructor, property, and
method call injection. In this brief
overview of the Unity Application Block,
you will see how it allows you to use con-
structor injection to inject a specific ob-
ject type into another class based on a
mapping in the container.

The listing in Figure 10 shows a simple
class named MyObjectWithInjected-
Logger that holds a reference to an ob-
ject that implements the ILogger
interface. The class constructor receives
in instance of a suitable class in its single
parameter, and then uses this logger in

the GetObjectStringResult method
that the class exposes.

To generate an instance of this class,
you use the Resolve method of the
UnityContainer class. When you
specify a type for which the container
contains no registration or mapping,
Unity will generate and return the type
you specify. In the code in Figure 11, it
will therefore just return an instance of
the MyObjectWithInjectedLogger
class. The code can then call the GetO-
bjectStringResult method and dis-
play the result.

However, Unity will still perform any
dependency injection tasks it can. In
terms of constructor injection, it will–by
default–look for mappings for depend-
ent objects defined in the constructor pa-
rameters. In the example, it will
therefore create and inject into the My-
ObjectWithInjectedLogger class an
instance of the MyLogger class. This is
because the registered default mapping
for the ILogger interface is to the My-
Logger class. 

Of course, if you change the configura-
tion to map the ILogger interface to the
MyFastLogger class, Unity will inject

Inject Some Unity: Continued from pg.54
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Dim loggerType As String = lst_LoggerType.SelectedValue
Dim myInstance As ILogger = myContainer.Resolve(Of ILogger)(loggerType)

String loggerType = lst_LoggerType.SelectedValue;
ILogger myInstance = myContainer.Resolve<ILogger>(loggerType);

C#

FIGURE 9

Visual Basic

...
<!-- Named mapping for ILogger to StandardLogger-->
<type type="ILogger" mapTo="MyLogger" name="StandardLogger">

<lifetime type="singleton" />
</type>
<!-- Named mapping for ILogger to SuperFastLogger-->
<type type="ILogger" mapTo="MyFastLogger" name="SuperFastLogger">

<lifetime type="external" />
</type>
...

FIGURE 8

XML

Dim myInstance As IMyInterface = myContainer.Resolve(Of MyDifferentObject)()

IMyInterface myInstance = myContainer.Resolve<MyDifferentObject>();

C#

FIGURE 7

Visual Basic
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Public Class MyObjectWithInjectedLogger

Private theLogger As ILogger

Public Sub New(ByVal log As ILogger)
theLogger = log

End Sub

Public Function GetObjectStringResult() As String 
Dim output As String = _

theLogger.WriteMessage("SOME REALLY IMPORTANT MESSAGE")
Return "Hi, I'm the 'MyObjectWithInjectedLogger' object, and I've got

" _
"a reference to some type of Logger!<p />" & output

End Function

End Class

public class MyObjectWithInjectedLogger 
{

private ILogger theLogger; 
public void MyObjectWithInjectedLogger(ILogger log)
{

theLogger = log;
}

public String GetObjectStringResult()
{
String output = theLogger.WriteMessage("SOME REALLY IMPORTANT MESSAGE");
return "Hi, I'm the 'MyObjectWithInjectedLogger' object, and I've got "

"a reference to some type of Logger!<p />" + output;
}

}

C#

FIGURE 10

Visual Basic
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MyObjectWithInjectedLogger myInstance 
= myContainer.Resolve<MyObjectWithInjectedLogger>()

lbl_Output.Text = myInstance.GetObjectStringResult();

C#

FIGURE 12

ABOUT THE AUTHOR
ALEX HOMER is a director of Stonebroom, Ltd.,

a software development, consulting, and training organ-
ization. He was formerly lead technical author and re-
viewer for Wrox, specializing in Microsoft Web and
database technologies.

an instance of this class instead. Yet there
is no dependency between the MyOb-
jectWithInjectedLogger class and
any specific type that implements the
ILogger interface. 

The screenshot in Figure 12 shows an
example application based on the code
you saw earlier. The code that runs when

the button is clicked instructs Unity to
create the MyObjectWithInjected-
Logger class, inject the registered ILog-
ger implementation (in this case the
MyFastLogger class), call the GetOb-
jectStringResult method, and display
the result.

JOIN THE CLUB

Become part of the Unity Commu-

Inject Some Unity: Continued from pg.55 nity—the only community that rhymes.
Go to http://www.codeplex.com/unity/,
register, and join in the discussions. ●

Dim myInstance As MyObjectWithInjectedLogger _
= myContainer.Resolve(Of MyObjectWithInjectedLogger)()

lbl_Output.Text = myInstance.GetObjectStringResult()

Visual Basic

FIGURE 11
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Who says GEEKS can’t sing?
Photos by Matt Clingan [matt.clingan@gmail.com]
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There is a demo I developed and

did in my session, “Integrating WPF &

WCF into Your Office Business

Applications”, at the Spring Dev

Connections that is pretty fun to do on

stage because it freaks people out with

a typical reaction of, “I had no idea you

could do that!”
Couple that with the fact that it’s

pretty darn easy to do means that I re-
ceived a large amount of e-mails after
the conference asking me for the de-
tailed steps on how to do it. What is it
that is so intriguing? Well it’s WPF run-
ning inside an Outlook E-mail Message. 

There is some history on this. I heard
it was easy to embed a WPF user control
in an Outlook Add-in VSTO solution.
After searching desperately on the Inter-
net for two straight days for some tidbits
of guidance and hacking a bunch of
failed code attempts I turned to Bill
Sheldon to help me out on how to do
this. After Bill showed me how easy it is
to do this and what a great job the VSTO
team did in the implementation within
Visual Studio 2008, I said two things to
Bill: “Awesome: that’s totally easy and
totally powerful” and “How are normal
humans supposed to figure this out if it’s
not documented anywhere?!” That in-
spired me to create a “How To” doc and
to do it as a demo at Dev Connections. 

In this article I am going to show you
how easy it is to build a powerful Visual
Studio Tools for Office (VSTO) applica-
tion for Outlook. Technically, this is a
VSTO-Outlook / WPF101 article, but the
application I show you how to build is
far from a “Hello World” application—I
have demoed this application a couple
times and it always gets great reviews.
In fact, many developers have taken my
code base, built their own WPF user
control, and either put it straight into
production or enhanced it and put it into
production because of its power and

how easy it is to
modify to fit
your custom
needs. 

WHAT THE
HECK IS VSTO?

So what is
VSTO? Well, VSTO allows you to build
Dynamic Office Documents in Managed
Code that run in process with Excel and
Word and it allows you to build add-ins
for most of the Office stack. You get to
leverage the existing Office plumbing
and manifest your .NET applications in
the rich user interface of Microsoft Of-
fice. Plus you get all the security support
(Group Policy / CAS) you are accus-
tomed to in building and deploying
.NET applications. In other words, like
with .NET in general, VSTO allows you
to leverage a lot of Microsoft plumbing
“for free.”

VSTO is one of those technologies I
immediately dismissed when I first
heard about it five or so years ago. I im-
mediately discounted it—until I dove in
and learned about its capabilities. I
quickly found VSTO version 1 (shipping
since October, 2003) addicting because
you could build so much with so little ef-
fort. With some effort, I built a number
of compelling applications in a fraction
of the time had I not had the Excel or
Word infrastructure. If you are like me
or many developers, you may have ques-
tioned why you’d build a .NET applica-
tion for the purpose of manifesting its
user interface in an office application
like Microsoft Excel, Word, or Outlook.
You are most certainly not going to man-
ifest your .NET applications in Outlook,
Word, or Excel every time, but there are
some compelling reasons to do it in a
number of scenarios, not the least of
which is for that enormous group of in-
formation workers who spend the bal-
ance of their professional lives in these
Office applications. 

Visual Studio® 2008 introduced an
array of new features aimed at a wide

>> Tim Huckaby

range of Office solution types. With Vi-
sual Studio 2008, you can build solu-
tions that incorporate the native
capabilities of the Office client appli-
cations (like Outlook) combined with
the sophisticated UI capabilities of
WPF that's connected to remote data
and services via WCF and use the RAD
features of LINQ to manipulate that
data. These new technologies provide
opportunities for building powerful so-
lutions with functionality that was pre-
viously difficult or impossible to
achieve.

Now that Office has evolved into a true
development platform, Office-based so-
lutions are becoming increasingly so-
phisticated, less document-focused, and
more loosely coupled. This article will
show you how easy it is to build robust
solutions that leverage the latest tech-
nologies.

WHAT DO YOU NEED TO BUILD AND
RUN VSTO APPLICATIONS?

The following step-by-step instruc-
tional for building the solution requires:
Visual Studio 2008, Office 2007, and
.NET 3.0 or above (WPF).

The following example solution is in
Visual Basic .NET, but there is so little
code it is totally simple to do the same
thing in C#. 

HOW TO BUILD THE APPLICATION

Exercise 1: Create the VS 2008 Project

From Visual Studio 2008 create a new
Excel 2007 Workbook Project:

File > New > Project...

Navigate through the project types to
Visual Basic > Office > 2007, and
then choose the Outlook 2007 Addin
Project template. Give the project an ap-
propriate name (i.e., VSTO-Outlook-
WPF-HowTo) and click the OK button.

Click “OK” to continue. (Figure 1)

VS

TIM HUCKABY 
WPF in Outlook with VSTO

WPF in Outlook with VSTO: 
Continued on pg.61
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Exercise 2: Create a WPF User Control

Add a WPF User Control to the Project:

Right-click the Project (i.e., VSTO-
Outlook-WPF-HowTo) and choose Add
> New Item…

From Categories, choose WPF, and
then choose the “User Control
(WPF)” template.

Keep the default name (UserCon-
trol1.xaml) and click Add. (Figure 2)

(i.e., VSTO-Outlook-WPF-HowTo) and
choose Add > New Item…

From Categories, choose General, and
then choose the “Text File” template.

Give the file the name App
Styles.xaml and click Add. (Figure 3)

Click the XAML tab in Visual Studio
and Paste the following code into App-
Styles.xaml:

Now, that amount of XAML might be
a bit intimidating at first when you stare

UserControl1.xaml will load into the
design surface in Visual Studio 2008.
For demo purposes the default size of
the control is fine.

For demo purposes you can drag a
button or a text box control onto the de-
sign surface of the WPF User Control if
you’d like, but for this exercise I am
going to use the XAML version of the In-
terKnowlogy Logo. 

Add an XAML file to the project to
house the logo file so that you can use it
as a resource: Right-click the Project

WPF in Outlook with VSTO: 
Continued from pg.60

FIGURE 1

WPF in Outlook with VSTO: 
Continued on pg.70
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FIGURE 3
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<!-- 
Shared Resources and Styles Resources & Styles defined in this Resource-
Dictionary will impact the entire application.  
-->
<ResourceDictionary

xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml"

xmlns:d="http://schemas.microsoft.com/expression/
interactivedesigner/2006"

xmlns:mc="http://schemas.openxmlformats.org/markup-compatibility/2006"
mc:Ignorable="d">

<DrawingBrush x:Key="iklogo">
<DrawingBrush.Drawing>

<DrawingGroup>
<DrawingGroup.Children>

<GeometryDrawing Geometry="F1 M 388.643,744.593L
376.308,744.593L 371.32,727.435L 366.949,734.071L 366.111,744.593L
355.489,744.593L 359.127,698.992L 369.748,698.992L 368.249,717.773L
379.915,698.992L 390.056,698.992L 379.431,715.659L 388.643,744.593 Z ">

<GeometryDrawing.Brush>
<RadialGradientBrush RadiusX="0.585274" 

RadiusY="0.443647" 
Center="0.500004,0.500007" 
GradientOrigin="0.500004,0.500007">

<RadialGradientBrush.GradientStops>
<GradientStop Color="#FF363C68" 

Offset="0"/>
<GradientStop Color="#FF363C68" 

Offset="0.241573"/>
<GradientStop Color="#FF1E2151" 

Offset="0.662921"/>
<GradientStop Color="#FF1E2151" 

Offset="1"/>
</RadialGradientBrush.GradientStops>
<RadialGradientBrush.RelativeTransform>

<TransformGroup/>
</RadialGradientBrush.RelativeTransform>

</RadialGradientBrush>
</GeometryDrawing.Brush>

</GeometryDrawing>
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<GeometryDrawing Geometry="M 376.009,654.237C
380.397,654.487 384.06,649.921 384.164,644.073C 384.265,638.225
380.771,633.251 376.383,633.003C 371.993,632.752 368.332,637.319
368.229,643.165C 368.128,649.015 371.621,653.987 376.009,654.237 Z ">

<GeometryDrawing.Brush>
<RadialGradientBrush RadiusX="0.589288" 

RadiusY="0.441918" 
Center="0.499998,0.499991" 
GradientOrigin="0.499998,0.499991">

<RadialGradientBrush.GradientStops>
<GradientStop Color="#FF363C68" 

Offset="0"/>
<GradientStop Color="#FF363C68" 

Offset="0.241573"/>
<GradientStop Color="#FF1E2151" 

Offset="0.662921"/>
<GradientStop Color="#FF1E2151" 

Offset="1"/>
</RadialGradientBrush.GradientStops>
<RadialGradientBrush.RelativeTransform>

<TransformGroup/>
</RadialGradientBrush.RelativeTransform>

</RadialGradientBrush>
</GeometryDrawing.Brush>

</GeometryDrawing>
<GeometryDrawing Brush="#FFB8D768" Geometry="F1 M

264.599,744.737L 255.285,744.737L 255.285,698.953L 264.599,698.953L
264.599,744.737 Z "/>

<GeometryDrawing Brush="#FFB8D768" Geometry="F1 M
291.804,744.737L 282.956,744.737L 282.956,729.473C 282.956,728.219
282.768,727.416 282.395,727.065C 282.021,726.715 281.552,726.539
280.989,726.539C 279.327,726.539 278.496,727.748 278.496,730.165L
278.496,744.737L 269.648,744.737L 269.648,720.441L 277.845,720.441L
277.845,723.879C 279.069,721.265 281.257,719.957 284.411,719.957C
286.068,719.957 287.468,720.297 288.611,720.972C 289.752,721.648
290.572,722.527 291.064,723.599C 291.556,724.673 291.804,726.539
291.804,729.195L 291.804,744.737 Z "/>

<GeometryDrawing Brush="#FFB8D768" Geometry="F1 M
310.525,720.441L 310.525,726.636L 305.963,726.636L 305.963,735.54C
305.963,736.76 306.179,737.484 306.613,737.713C 307.047,737.944
307.497,738.057 307.961,738.057C 308.681,738.057 309.535,737.928
310.525,737.669L 310.525,744.445C 308.768,744.833 307.041,745.027
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305.345,745.027C 302.604,745.027 300.589,744.399 299.303,743.141C
298.015,741.887 297.371,739.883 297.371,737.133L 297.392,734.295L
297.392,726.636L 294.04,726.636L 294.04,720.441L 297.392,720.441L
297.527,712.552L 305.963,712.408L 305.963,720.441L 310.525,720.441 Z "/>

<GeometryDrawing Brush="#FFB8D768" Geometry="F1 M
327.86,729.735C 327.845,728.091 327.537,726.987 326.933,726.421C
326.331,725.857 325.584,725.572 324.695,725.572C 322.583,725.572
321.525,726.96 321.525,729.735M 328.417,736.025L 336.707,736.621C
336.216,739.004 334.963,741.032 332.949,742.708C 330.932,744.383
328.207,745.219 324.772,745.219C 320.949,745.219 317.901,744.04
315.625,741.677C 313.349,739.315 312.212,736.387 312.212,732.887C
312.212,729.261 313.335,726.2 315.583,723.703C 317.827,721.205
320.823,719.957 324.572,719.957C 328.2,719.957 331.135,721.135
333.372,723.485C 335.611,725.839 336.729,729.041 336.729,733.093C
336.729,733.427 336.723,733.889 336.707,734.475L 321.525,734.475C
321.556,736.017 321.808,737.16 322.284,737.907C 322.76,738.653
323.667,739.025 325.005,739.025C 326.939,739.025 328.075,738.027
328.417,736.025 Z "/>

<GeometryDrawing Brush="#FFB8D768" Geometry="F1 M
348.667,744.737L 340.192,744.737L 340.192,720.441L 347.549,720.441L
347.549,725.42C 348.403,721.779 350.389,719.957 353.511,719.957C
353.824,719.957 354.259,719.989 354.813,720.052L 354.813,728.521C
354.183,728.361 353.62,728.281 353.125,728.281C 350.153,728.281
348.667,730.047 348.667,733.576L 348.667,744.737 Z "/>

<GeometryDrawing Brush="#FFB8D768" Geometry="F1 M
410.432,744.737L 401.584,744.737L 401.584,729.473C 401.584,728.219
401.397,727.416 401.024,727.065C 400.649,726.715 400.183,726.539
399.617,726.539C 397.956,726.539 397.125,727.748 397.125,730.165L
397.125,744.737L 388.277,744.737L 388.277,720.441L 396.472,720.441L
396.472,723.879C 397.699,721.265 399.887,719.957 403.036,719.957C
404.695,719.957 406.095,720.297 407.24,720.972C 408.381,721.648
409.199,722.527 409.693,723.599C 410.185,724.673 410.432,726.539
410.432,729.195L 410.432,744.737 Z "/>

<GeometryDrawing Brush="#FFB8D768" Geometry="F1 M
426.291,739.412C 427.659,739.412 428.493,738.651 428.795,737.123C
429.093,735.596 429.247,734.003 429.247,732.343C 429.247,730.08
429.032,728.451 428.605,727.455C 428.18,726.459 427.417,725.959
426.312,725.959C 425.297,725.959 424.555,726.472 424.084,727.5C
423.615,728.529 423.38,730.221 423.38,732.579C 423.38,735.347
423.62,737.179 424.107,738.073C 424.592,738.967 425.319,739.412
426.291,739.412 Z M 426.156,745.219C 422.397,745.219 419.413,743.969
417.199,741.464C 414.985,738.959 413.879,736.021 413.879,732.648C
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413.879,729.024 415.033,726 417.345,723.583C 419.653,721.167
422.659,719.957 426.359,719.957C 430.087,719.957 433.084,721.151
435.349,723.536C 437.612,725.921 438.748,728.912 438.748,732.505C
438.748,736.133 437.599,739.156 435.304,741.583C 433.009,744.011
429.959,745.219 426.156,745.219 Z "/>

<GeometryDrawing Brush="#FFB8D768" Geometry="F1 M
472.863,720.441L 465.689,744.737L 459.293,744.737L 456.284,731.565L
453.184,744.737L 446.857,744.737L 439.52,720.441L 448.257,720.441L
451.268,732.344L 454.067,720.441L 460.72,720.441L 463.519,732.227L
466.688,720.441L 472.863,720.441 Z "/>

<GeometryDrawing Brush="#FFB8D768" Geometry="F1 M
484.224,744.737L 475.469,744.737L 475.469,712.117L 484.224,712.117L
484.224,744.737 Z "/>

<GeometryDrawing Brush="#FFB8D768" Geometry="F1 M
500.112,739.412C 501.479,739.412 502.312,738.651 502.615,737.123C
502.916,735.596 503.067,734.003 503.067,732.343C 503.067,730.08
502.853,728.451 502.425,727.455C 501.999,726.459 501.236,725.959
500.132,725.959C 499.116,725.959 498.376,726.472 497.905,727.5C
497.433,728.529 497.199,730.221 497.199,732.579C 497.199,735.347
497.441,737.179 497.925,738.073C 498.412,738.967 499.139,739.412
500.112,739.412 Z M 499.976,745.219C 496.219,745.219 493.233,743.969
491.017,741.464C 488.805,738.959 487.7,736.021 487.7,732.648C
487.7,729.024 488.853,726 491.164,723.583C 493.473,721.167 496.479,719.957
500.179,719.957C 503.907,719.957 506.903,721.151 509.169,723.536C
511.432,725.921 512.567,728.912 512.567,732.505C 512.567,736.133
511.419,739.156 509.123,741.583C 506.828,744.011 503.78,745.219
499.976,745.219 Z "/>

<GeometryDrawing Brush="#FFB8D768" Geometry="F1 M
526.66,730.604C 528.393,730.604 529.26,729.633 529.26,727.689C
529.26,725.697 528.369,724.7 526.593,724.7C 524.832,724.7 523.952,725.711
523.952,727.736C 523.952,729.648 524.853,730.604 526.66,730.604 Z M
524.352,744.484C 524.024,744.472 523.693,744.464 523.365,744.464C
521.831,744.464 521.065,744.973 521.065,745.995C 521.065,746.936
521.649,747.541 522.816,747.813C 523.988,748.084 525.552,748.221
527.505,748.221C 529.355,748.221 530.541,748.051 531.073,747.711C
531.603,747.373 531.868,746.904 531.868,746.307C 531.868,745.887
531.748,745.536 531.511,745.255C 531.271,744.972 530.703,744.805
529.809,744.757M 539.692,714.924L 539.505,721.409L 539.077,721.385C
538.265,721.337 537.689,721.312 537.345,721.312C 535.949,721.312
535.111,721.628 534.824,722.256C 536.517,723.752 537.363,725.56
537.363,727.677C 537.363,730.163 536.436,732.031 534.584,733.28C
532.731,734.528 530.215,735.153 527.033,735.153C 526.959,735.153



MyDevConnections Magazine • April 20-23, 2008 Orlando, FL • www.DevConnections.com 67

Experience the POWER of the Connection!

526.568,735.139 525.864,735.104C 525.203,735.076 524.86,735.059
524.831,735.059C 523.376,735.059 522.647,735.459 522.647,736.256C
522.647,736.959 523.291,737.333 524.579,737.381L 531.921,737.716C
534.6,737.844 536.567,738.641 537.815,740.107C 539.068,741.573
539.692,743.285 539.692,745.247C 539.692,747.572 538.764,749.472
536.913,750.945C 535.057,752.419 531.453,753.156 526.096,753.156C
517.836,753.156 513.705,751.123 513.705,747.056C 513.705,744.839
514.799,743.292 516.983,742.415C 515.543,741.347 514.823,740.079
514.823,738.612C 514.823,736.219 516.264,734.416 519.145,733.203C
516.824,732.076 515.663,730.195 515.663,727.571C 515.663,725.169
516.64,723.3 518.599,721.963C 520.557,720.625 523.244,719.957
526.656,719.957C 528.213,719.957 529.632,720.125 530.908,720.461C
531.427,716.64 533.307,714.731 536.549,714.731C 537.291,714.731
538.339,714.797 539.692,714.924 Z "/>

<GeometryDrawing Brush="#FFB8D768" Geometry="F1 M
563.164,720.441L 554.273,746.828C 553.588,748.824 552.612,750.376
551.337,751.489C 550.061,752.601 548.096,753.156 545.444,753.156C
544.807,753.156 543.324,753.091 540.999,752.964L 540.999,746.188C
542.153,746.381 543.22,746.479 544.2,746.479C 546.745,746.479
548.021,745.897 548.021,744.737C 548.021,744.339 547.893,743.789
547.641,743.089L 539.508,720.441L 549.017,720.441L 552.744,733.281L
556.683,720.441L 563.164,720.441 Z "/>

<GeometryDrawing Brush="#FFB8D768" Geometry="M
461.223,621.667C 469.979,621.755 477.032,630.944 476.929,642.125C
476.827,653.308 469.601,662.355 460.848,662.268C 452.091,662.18
445.036,652.991 445.139,641.808C 445.244,630.628 452.471,621.58
461.223,621.667 Z M 463.235,611.637C 474.707,611.752 483.944,625.476
483.787,642.195C 483.635,658.911 474.147,672.451 462.669,672.336C
451.195,672.221 441.959,658.493 442.113,641.777C 442.267,625.06
451.755,611.521 463.235,611.637 Z M 459.695,631.701C 464.308,631.748
468.036,636.301 467.985,641.836C 467.932,647.371 464.123,651.847
459.504,651.8C 454.889,651.755 451.167,647.201 451.216,641.667C
451.271,636.132 455.076,631.657 459.695,631.701 Z "/>

<GeometryDrawing Brush="#FFB8D768" Geometry="M
363.8,592.255C 382.405,603.676 404.245,621.156 411.097,628.769C
421.539,640.361 425.056,653.508 419.532,667.035C 415.551,676.789
403.716,689.979 394.499,698.273C 403.577,685.639 406.584,680.932
410.347,671.025C 413.824,661.867 413.945,642.601 400.573,627.329C
392.285,617.86 386.483,612.159 363.8,592.255 Z "/>

<GeometryDrawing Geometry="M 459.772,642.167C
459.04,642.296 403.069,653.604 403.069,653.604C 403.069,653.604
394.889,655.737 389.844,657.128C 377.831,660.439 368.251,659.169
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364.813,657.832C 361.345,656.335 358.819,655.883 355.429,657.068C
350.743,658.679 349.365,658.924 344.72,661.032C 341.793,663.089
344.56,665.708 346.663,665.841C 349.416,666.015 354.213,666.592
358.045,667.149C 361.688,667.681 362.637,669.867 363.061,673.232C
363.608,677.533 362.603,678.872 363.307,685.051C 363.575,687.383
365.504,688.06 365.887,688.143C 369.928,689.016 378.552,689.749
382.885,687.344C 384.335,686.539 385.807,685.919 386.476,682.837C
387.165,679.675 388.281,672.005 389.339,668.987C 390.435,665.861
391.333,664.209 394.124,662.647C 398.671,660.1 402.563,658.608
409.695,656.685C 413.448,655.673 459.108,644.189 459.989,643.953C
461.719,643.489 461.405,641.88 459.772,642.167 Z ">

<GeometryDrawing.Brush>
<RadialGradientBrush RadiusX="0.380524"

RadiusY="0.956173"
Center="0.499997,0.500012"
GradientOrigin="0.499997,0.500012">

<RadialGradientBrush.GradientStops>
<GradientStop Color="#FF363C68"

Offset="0"/>
<GradientStop Color="#FF363C68" 

Offset="0.241573"/>
<GradientStop Color="#FF1E2151" 

Offset="0.662921"/>
<GradientStop Color="#FF1E2151" 

Offset="1"/>
</RadialGradientBrush.GradientStops>
<RadialGradientBrush.RelativeTransform>

<TransformGroup/>
</RadialGradientBrush.RelativeTransform>

</RadialGradientBrush>
</GeometryDrawing.Brush>

</GeometryDrawing>
</DrawingGroup.Children>

</DrawingGroup>
</DrawingBrush.Drawing>

</DrawingBrush>
</ResourceDictionary>

FIGURE 4
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<UserControl
xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml" 
x:Class="UserControl1"
Width="300" Height="300">

<UserControl.Resources>
<ResourceDictionary>

<ResourceDictionary.MergedDictionaries>
<ResourceDictionary Source="AppStyles.xaml"/>

</ResourceDictionary.MergedDictionaries>
</ResourceDictionary>

</UserControl.Resources>
<Grid>

</Grid>
</UserControl>

FIGURE 5

<UserControl
xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml" 
x:Class="UserControl1"
Width="300" Height="300" Background="{DynamicResource iklogo}">

<UserControl.Resources>
<ResourceDictionary>

<ResourceDictionary.MergedDictionaries>
<ResourceDictionary Source="AppStyles.xaml"/>

</ResourceDictionary.MergedDictionaries>
</ResourceDictionary>

</UserControl.Resources>
<Grid>

</Grid>
</UserControl>

FIGURE 6
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FIGURE 7

at it. But, remember that we are living in
a vector-based world in WPF. That
XAML above is simply the InterKnowl-
ogy logo. I used Microsoft Expression
Design to open the original Adobe Illus-
trator artwork. I then used Expression
Design to export our logo to XAML.
What I got was a <DrawingBrush>. You
could do this just as easily with Expres-
sion Design if you have the Adobe Illus-
trator artwork version of your logo. The
DrawingBrush tag is what you should
stare at in the XAML. The logo in app-
styles in design view will not render in
Visual Studio, though. So, don’t expect
it to. It is a resource file that could tech-

nically house a number of styles you’d
use in your application.

Now you need to link the Resource
File you just created to the User Control
so that you can embed the logo into the
user control. In Microsoft Expression
Blend this is simple:

Open the Solution in Microsoft Ex-
pression Blend. Open the User Control.
Choose the Resources Tab. Right-click
the User Control, choose the “Link to
Resources Directory Choice”, and then
choose AppStyles.xaml.

If you don’t have Microsoft Expression
Blend, change the XAML in your user
control to look like Figure 5.

Notice in the XAML (Figure 6) how
AppStyles.xaml has been added as a

WPF in Outlook with VSTO: 
Continued from pg.61

resource to the user control. At this
point you may get a bit frustrated with
Visual Studio 2008 because it might
throw some errors trying to figure out
how to render the XAML that Blend
produced. 

Now fill the control’s background with
the logo. From Blend, with the user con-
trol selected, choose the Properties tab.
Locate the Background property in
Brushes and choose the advance Fill
property (it’s a tiny box next to the brush
rectangle). Choose the Local Resource
option, and then choose the logo (in the
XAML above the InterKnowlogy logo is
named IKLogo). From Blend, the user
control will now render the logo as its

WPF in Outlook with VSTO: 
Continued on pg.71
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background in design time. 

The XAML in your user control now
looks like Figure 6.

So, if you don’t have Blend then replace
the previous code into the XAML window
of your user control in VS 2008 with the
code above. Visual Studio 2008 will be
able to render the logo in design time.

Notice in the XAML how Blend added

Right-click the Project (i.e., VSTO-
Outlook-WPF-HowTo) and choose Add
> New Item…

From Categories, choose Office, and
then choose the “Outlook Form Re-
gion” template.

Keep the default name (FormRe-
gion1.vb) and click Add to start the
New Outlook Form Region Wizard.
See Figure 7.

the logo as a Dynamic Resource to the
user control.

Note: As you switch back and forth
from Blend to VS 2008 and back and
save your work each time you’ll be asked
to reload. You should answer “yes” in all
cases, of course. 

Exercise 3: Add an Outlook Form Region

and Bind the WPF User Control to It

Add an Outlook Form Region Control
to the Project:

WPF in Outlook with VSTO: 
Continued on pg.72

WPF in Outlook with VSTO: 
Continued from pg.70

FIGURE 8
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FIGURE 9

Click next to continue. See Figure 10.

Keep the default choice of Mail Mes-
sage because you are only going have
your WPF user control run in the e-mail
mode of Outlook and choose Finish to
complete the wizard. See Figure 11.

Save and compile the project by

There are four types of Outlook Form
Regions. Chose the Adjoining type which
will append the WPF user control to the
bottom of the form and click Next to con-
tinue.  See Figure 9.

Keep the default name and clear the
“Reading Pane” choice. You are only
going to display the user control in e-mail
messages in read and compose mode.

The next step in the wizard is how you
want to create the Outlook Form Re-
gion. You can import from an existing
Outlook Form Storage File (OFS) or you
can design a new Form Region. Chose
to design a new Form Region and press
Next to continue. See Figure 8.

WPF in Outlook with VSTO: 
Continued on pg.73

WPF in Outlook with VSTO: 
Continued from pg.71
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choosing “Build Solution” from the VS
2008 Build menu. 

Because VSTO can technically only
host Windows Forms controls you need
to add an Element Host control to the
Outlook Forms Region Control:

From the Toolbox, navigate down to

stance by sizing the control) it will dis-
appear, but you can bring it back by
clicking the very small right arrow on the
top left of the Element Host control.

Choose UserControl1 as the Select
Hosted Content from the drop-down
list in the Element Hosts Task dialog.

the WPF Interoperability section,
choose the ElementHost Control and
drag it onto the surface of the Outlook
Forms Region Control.

The Element Hosts Task dialog will
automatically come to focus allowing
you to choose UserControl1 as its hosted
content. If you accidentally click outside
of the Element Hosts Task dialog (for in-

Experience the POWER of the Connection!

WPF in Outlook with VSTO: 
Continued on pg.76

WPF in Outlook with VSTO: 
Continued from pg.72

FIGURE 10



My     ConnectionsDev

74 www.DevConnections.com • April 20-23, 2008 Orlando, FL • MyDevConnections Magazine

FIGURE 11
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FIGURE 12

FIGURE 13
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Resize the Element Host control so
that it properly displays the WPF User
Control. See Figure 12.

You now have the WPF User Control
properly housed inside the Windows
Forms Element Host within an Outlook
Forms Region Control. Now it’s time to
run the solution.

Now you are ready to test the solution.
Hit F5 to compile and run (Debug >
Start Debugging from the VS 2008
menu). Outlook will automatically run.
Create a new e-mail message and Notice
that the WPF user control hosting the
logo is running in the e-mail message.
See Figure 13.

Exercise 4 (Optional): Use Expression
Blend to Animate the Logo

One of the most exciting things about
XAML is how easy and powerful it is to
animate. You will need Microsoft Ex-
pression Blend to animate the logo eas-
ily, but you can copy the XAML below
and paste it into VS 2008 if you do not
have Blend.

From Blend, give the user control a
name: With the user control selected,
choose the properties tab in Blend. The
Name property is the very first property
on the top of the tab. Give the user con-
trol the name “IKUserControl”. This will
add the following line in UserControl1.
Xaml. See Figure 14.

“Flip Y axis” button to flip the logo
upside down.

2. Click the “Rotate” Button, and then
enter “360” in degrees to rotate the
logo 360.

3. Click the “Flip” Button, and then the
“Flip Y axis” button to flip the logo
right side up.

Now you are ready to test your VSTO
Outlook Add-In. Save the Files in
Blend, but don’t run the solution from
Blend because Blend cannot run a
VSTO application. Switch back to Vi-
sual Studio. It will warn you to reload
the application because it’s smart
enough to see you have just edited it in
Blend. 

If you don’t have Blend you can still
use the XAML created in the process
above in Visual Studio to look like 
Figure 17.

Hit F5 to compile and run (Debug >
Start Debugging from the VS 2008
menu). Outlook will automatically run.
Create a new e-mail message and notice
that WPF user control hosting the logo is
running in the e-mail message. Double-
click the logo and it will spin.

SUMMARY

Is that not cool or what?! The first
question I get is typically, “What hap-
pens if I send that e-mail to someone not

Now, from Blend, with the user con-
trol still selected, add an event: Click the
+ on the Event Tab within the Interac-
tion tab (it defaults in Blend on the left
side). In the “When” clause, make sure
the “IKUserControl” is selected and
choose the “MouseDoubleClick” event as
the one being raised. Blend will look like
Figure 15.

Click the “+” sign next to the Mouse-
DoubleClick event to create a new time-
line to run the animation in. Blend will
warn you that a Timeline does not exist
and it is going to create one. 

Now, this is a little tricky to explain in
magazine article. It’s a lot easier to see
it done, so follow along carefully while
staring at the screenshot below. From
the Objects and Timeline section of the
Interaction tab, click on the green “+”
sign (record keyframe) to create a time-
line start in XAML. This will add a white
oval in the start of the timeline. Now
drag the yellow timeline out for a half
second or so by clicking on the “0” in the
timeline and dragging it half way to “1”.
(.4 or .6 is fine–you don’t have to be
exact here–you are simply defining how
long your animation is going to run and
can easily tweak it later. Blend will look
like the screenshot in Figure 16.

Now that you have a timeline tied to
an event, you are ready to animate it. In
Blend, go to the Properties tab and click
the Transform section near the bottom. 

1. Click the “Flip” Button, and then the
WPF in Outlook with VSTO: 

Continued on pg.77

WPF in Outlook with VSTO: 
Continued from pg.73

x:Name="IKUserControl"

FIGURE 14
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running Outlook?” Well, the add-in only
runs in Outlook so nothing weird hap-
pens. The e-mail goes as normal. Now,
there are numerous business scenarios
for this, but let me provide a scenario for
an Outlook add-in that my company just
built for a Fortune 500 company. Pro-
grammatically, the add-in only runs for
their marketing and sales department.
And when the users populate the To:
line of an e-mail with an e-mail address,
the add-in looks up the contact in their
Oracle-based CRM system and popu-

lates a Form in a WPF user control in the
Outlook Form region like I do in the
demo above. That way, the user is much
more efficient never having to leave Out-
look to look up and analyze a customer
in their CRM system. 

VSTO delivers significant enhance-
ments to the development of business so-
lutions based on the Microsoft Office
stack. VSTO addresses some of the
biggest challenges that Office solution
developers are facing today, including
separation of data and view elements,
server-side and offline scenarios, and
seamless integration with the Visual Stu-

FIGURE 15

WPF in Outlook with VSTO: 
Continued from pg.76

ABOUT THE AUTHOR
TIM HUCKABY is CEO of InterKnowlogy—ex-

perts in Microsoft .NET and Microsoft Platforms. Tim has
worked on and with product teams at Microsoft for many
years, has authored books & several publications, and
is a frequent conference speaker. You can reach him at
TimHuck@InterKnowlogy.com

FIGURE 16

dio toolset including support for debug-
ging, click once deployment, and all the
goodness of .NET in between. With full
design-time support and a number of
other compelling features, VSTO is a
must have in your developer tool box. ●
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<UserControl
xmlns="http://schemas.microsoft.com/winfx/2006/xaml/presentation"
xmlns:x="http://schemas.microsoft.com/winfx/2006/xaml" 

x:Class="UserControl1"
Width="300" Height="300" Background="{DynamicResource iklogo}"

x:Name="IKUserControl">
<UserControl.Resources>

<ResourceDictionary>
<ResourceDictionary.MergedDictionaries>

<ResourceDictionary Source="AppStyles.xaml"/>
</ResourceDictionary.MergedDictionaries>
<Storyboard x:Key="OnMouseDoubleClick1">

<PointAnimationUsingKeyFrames BeginTime="00:00:00" 
Storyboard.TargetName="{x:Null}" 
Storyboard.TargetProperty="(UIElement.

RenderTransformOrigin)">
<SplinePointKeyFrame KeyTime="00:00:00"

Value="0,0"/>
<SplinePointKeyFrame KeyTime="00:00:00.5000000"

Value="0.5,0.5"/>
</PointAnimationUsingKeyFrames>
<DoubleAnimationUsingKeyFrames BeginTime="00:00:00" 

Storyboard.TargetName="{x:Null}" 
Storyboard.TargetProperty="(UIElement.

RenderTransform).(TransformGroup.Children)[0].(ScaleTransform.ScaleY)">
<SplineDoubleKeyFrame KeyTime="00:00:00" Value="1"/>
<SplineDoubleKeyFrame KeyTime="00:00:00.5000000" 

Value="1"/>
</DoubleAnimationUsingKeyFrames>
<DoubleAnimationUsingKeyFrames BeginTime="00:00:00" 

Storyboard.TargetName="{x:Null}" 
Storyboard.TargetProperty="(UIElement.

RenderTransform).(TransformGroup.Children)[2].(RotateTransform.Angle)">
<SplineDoubleKeyFrame KeyTime="00:00:00" Value="0"/>
<SplineDoubleKeyFrame KeyTime="00:00:00.5000000" 

Value="-360"/>
</DoubleAnimationUsingKeyFrames>

</Storyboard>
</ResourceDictionary>

</UserControl.Resources>
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<UserControl.RenderTransform>
<TransformGroup>

<ScaleTransform ScaleX="1" ScaleY="1"/>
<SkewTransform AngleX="0" AngleY="0"/>
<RotateTransform Angle="0"/>
<TranslateTransform X="0" Y="0"/>

</TransformGroup>
</UserControl.RenderTransform>
<UserControl.Triggers>

<EventTrigger RoutedEvent="Control.MouseDoubleClick">
<BeginStoryboard Storyboard="{StaticResource 

OnMouseDoubleClick1}"/>
</EventTrigger>

</UserControl.Triggers>
<Grid>

</Grid>
</UserControl>

FIGURE 17
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INTRODUCTION

You are committed to building the best
software you can. Your ultimate goal is
the highest quality software built at the
lowest possible cost, shipped in the
shortest amount of time. Of course, that
can be difficult to achieve. Often you
must sacrifice one (or more) of those
three goals in order to ship your soft-
ware. Perhaps you ship late in order to
ensure the highest quality. Or maybe you
go over budget, hiring additional devel-
opers and testers to ensure the quality.
Worse yet, you ship on time and on
budget, but the quality is sub-par. Rarely
do you see software projects that success-
fully achieve all three goals (but that is a
discussion for another article).

What we know for sure is that poor
quality software costs money; that is to
say, when you ship poor quality software,
there is a financial impact to you and
your users because of it. In 2002 the Na-
tional Institute of Standards in Technol-
ogy (NIST) determined that software
quality errors cost U.S. businesses over
$59 billion dollars in productivity annu-
ally. Over half of this cost is borne by end
users in the form of error avoidance
(workarounds) and mitigation activities
(help desk calls, etc). The smaller
amount is borne by software developers
in the form of bug fixes and additional
testing resources.

What if you could significantly reduce
the number of bugs? Of course, the cost
to fix a bug is determined largely by when
the bug is discovered. The earlier in the
development cycle that you find the bug,
the less it costs to fix it. To quote Soft-
ware Testing by Ron Patten…

“The costs are logarithmic—that is,
they increase tenfold as time increases.
A bug found and fixed during the early
stages when the specification is being
written might cost next to nothing, or $1
in our example. The same bug, if not
found until the software is coded and
tested, might cost $10 to $100. If a cus-
tomer finds it, the cost could easily be

thousands or
even millions of
dollars.”

The incre-
mental cost is
due not only to
the costs borne
by the end user,

but also the cost of simply finding the
bug. Think about when you write code. If
I ask you about code you wrote today,
you could tell me everything about it,
nearly line by line. If I ask you tomorrow,
maybe you’ll lose a little detail. If I ask
you in a week it is hard for you to remem-
ber the code. And code you wrote a
month ago, or six months ago…forget it,
you don’t remember that code at all.

“For most projects, the cost of finding
a bug is much larger than the cost of fix-
ing the bug. Indeed, in many cases, once
a bug has been isolated, the fix is trivial.
The expensive part is detecting and then
isolating the bug.”

In this two-part article I will discuss
how you can improve the quality of the
software you create and reduce the num-
ber of bugs using three very important
techniques.

• Validate Capabilities

• Ensure Maintainability

• Understand Overall Quality

In order to execute on these techniques
you need a set of tools that are capable of
the tasks you need to perform. While
there are many tool choices out there I
will focus on using Visual Studio Team
System 2008. I will be showcasing fea-
tures throughout Visual Studio Team
System, and will describe with Team Edi-
tions the features are included in. 

In Part 1 of this short series I will dis-
cuss how you can use Visual Studio Team
System 2008 to validate the capabilities
of your software projects. In Part 2, I will
focus on how you can use Visual Studio
Team System to ensure the maintainabil-
ity of your software projects, and under-
stand and communicate their overall
quality in a measurable way.

>> Doug Seven

The available Team Editions are:

• Visual Studio Team System 2008
Architecture Edition

• Visual Studio Team System 2008
Development Edition

• Visual Studio Team System 2008
Database Edition

• Visual Studio Team System 2008
Test Edition

• Visual Studio Team System 2008
Team Foundation Server

VALIDATING CAPABILITIES

As you write code and produce usable
software it is important that you validate
along the way that the code you are writ-
ing – the software you are producing –
works as it is intended. Imagine if an au-
tomobile assembly line didn’t test what
it was building until it rolled out of the
plant. Imagine if an airplane was never
tested before its first passenger flight. In
all manufacturing industries there are
tools and techniques in place to test what
is being built as it is being built, rather
than waiting until it is complete before
testing. Additionally there are tools and
techniques in place to test the product
after it is built, but before it is used by
customers. Why should the software in-
dustry be any different?

UNIT TESTS VERIFY INDIVIDUAL PARTS
OF THE CODE ARE WORKING

It is so rare that we test the entirety of
something to validate it. In all walks of
life we frequently test or investigate
things in small, understandable pieces.
As I am sure you have experienced by
now, unit tests are a great way to validate
that your code is working as expected in
small, understandable pieces. A rich,
complete unit test suite is a killer tool to
give you immediate feedback when you
add or edit code in your application and
to let you know that nothing else broke
as a result. Unit tests are a software engi-
neer’s version of those manufacturing
tests that happen during assembly. With

VS
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unit tests you can test a small piece of
code to ensure it works as expected be-
fore integrating it into the larger system.
This will help find and isolate bugs be-
fore they get integrated (and after),
which greatly reduces both the likelihood
of a bug making it to release, and the
time it takes to find the source of a bug if
one does make it out into the wild.

Obviously unit tests are not the only
testing you should do, but if you do use
them you have likely learned that you
can’t live without them.

For the release of Visual Studio 2008
the unit testing framework and tooling
was “trickled down” to Visual Studio
2008 Professional Edition (previously
unit testing was part of Visual Studio
2005 Team System in the Software De-
velopers Edition, Software Testers Edi-
tion, or in Team Suite).

CODE COVERAGE IDENTIFIES WHAT
CODE HAS BEEN TOUCHED BY A TEST

Tightly coupled to unit testing is Code
Coverage. A code coverage report will tell
me how much of the code in my applica-
tion was exercised on the preceding test
run…and perhaps more importantly,
how much code is currently not being
tested. Of course, the goal is to have high
code coverage numbers, and where there
is a deficiency in coverage to be able to
quickly find the code that is not being
tested. Once discovered, you can then
write the necessary tests.

In my previous role as a Senior Devel-
opment Lead within Microsoft.com, I
worked with a team that regularly
achieved code coverage numbers rang-
ing from 85% - 95% on a code base of
tens of thousands of lines of code. The
advantages of this level of coverage are
fantastic. As a team we could validate
the capabilities of the software we were
producing at any time. If a developer
made a change, she would know imme-
diately, before checking it in, that it

• Click Add to Cart – browser per-
forms an AJAX call

• Click Check Out – browser goes to
checkout.aspx page.

With a Web test you can play back this
sequence to verify that the correct HTTP
responses are coming back from the Web
server (note: the HTML is not validated,
just the URLs and response codes). This
is a great way to verify the intended exe-
cution path. 

Using Web tests to validate that a se-
ries of requests and responses are occur-
ring as expected can help you
tremendously. With the release of
ASP.NET AJAX and the importance
AJAX-enabled sites play in today’s online
world, you need good tools for verifying
“traditional” Web applications and more
modern AJAX applications. 

Web testing was available in Visual
Studio 2005 Team System. Support for
AJAX calls was added in Visual Studio
Team System 2008. Web testing is avail-
able in the Test Edition and Team Suite.

LOAD TESTS VALIDATE PERFORMANCE
CAPABILITIES OF THE APPLICATION

Load Tests are critical to validating
that your application can handle the ex-
pected load that it will be under. From a
developer’s perspective, you can use load
testing to identify a baseline of load ca-
pability and measure development from
the baseline. From a tester’s perspective
you can use load testing against a QA or
staging environment to verify that the
system you are testing can handle the
load you intend for it.

Depending on how you configure the
Load Test you can see if your application
can handle a defined set of user load for
a duration of time, or see how much load
your application can handle by slowly in-
creasing the load. Both are valid tests,
and tell you slightly different things
about your application.

worked as expected, and nothing else
broke as a result.

The combination of unit testing and
code coverage enabled the team to
achieve these high numbers (along with
a diligent discipline of Test-Driven De-
velopment).

Code Coverage tooling is part of Vi-
sual Studio Team System 2008 (and
2005) in either the Development Edition
or the Test Edition or in Team Suite.

WEB TESTING ENSURES WEB-BASED
APPLICATIONS WORK AS EXPECTED

Web testing is not new, however; Web
testing tooling continues to improve.
The purpose of Web testing from a de-
veloper’s perspective (as opposed to a
testers perspective) is to get early feed-
back that the Web user experience is
fundamentally working as expected.
Web testing is different than user ac-
ceptance testing (UAT). In the UAT the
tester verifies that the functionality
being tested is accurate from a user’s
perspective. This includes not only the
test path, but the UI as well – layout,
color, etc. From a developer’s perspec-
tive, Web testing is really about validat-
ing that the correct Request/Response
pairing happens, saving the UI valida-
tion for later (since the layout can
change a lot during development).

Web testing with Visual Studio Team
System is about recording a stream of
HTTP requests and responses with the
ability to play them back at anytime to
validate the same request/responses
happen. For example, you can record a
sequence of events like the following:

• Navigate to the home page of a Web
site.

• Click on the link for Products –
browser goes to the products.aspx
page.

• Click on the first Product in the list
– browser goes to the productde-
tails.aspx?id=1 page.

Build Better Software: Continued from pg.80
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In Visual Studio Team System 2008
Test Edition the load test capabilities
were enhanced to include support for
User Pacing. This enables you to build a
realistic model of client usage into your
load test. With user pacing you can spec-
ify the number of times a client performs
a specific set of action (modeled by a
Web or unit test) within an hour. By
doing this you can build a usage model
that looks very much like your produc-
tion environment.

For example, you could specify that
within your load test a user will perform
the following actions:

• Visit the home page five times an
hour.

• Browse the product catalogue twice
an hour.

• Make a purchase once an hour.

When the load test runs it will use the
user pace model to run each test the ap-
propriate times per hour, per user. If you
ran the load test for 5-hours, and simu-
lated 100 concurrent users, then the first
test, for example, would be executed 25-
times per hour (five times per hour per
user) for a total of 2,500 executions,
while the third test would only execute
500 times (once per hour per user).

Load testing was available in Visual
Studio 2005 Team System. Support for
user pacing was added in Visual Studio
Team System 2008. Load testing is
available in the Test Edition and Team
Suite.

PERFORMANCE PROFILER ANALYZES
THE APPLICATION TO FIND CRITICAL
RESOURCE USAGE

Along with validating the functional
capabilities of your application you need
to be able to test the performance of your
application. Performance Profiling pro-
vides the tools to test your application for
potential issues with resources like CPU
time and memory. 

The Performance Profiler is available
in Visual Studio Team System 2008 De-
velopment Edition.

CONCLUSION

Poor quality software costs money. It
costs the end users money in terms of
lost productivity, it costs us money in
terms of supporting these customers,
and it costs us money in terms of re-
sources that we have to allocate to find
and fix bugs (not to mention release up-
dates). The earlier in the product devel-
opment cycle you can find and mitigate a
bug (or potential bug) the less that bug
will cost. The goal of this article series is
to introduce you to the tools and tech-
niques you can use to ensure quality
early in the development cycle. By vali-
dating the capabilities of your applica-
tions during development you can
eliminate many of the bugs that may
have sneakily slipped by.

In this article you saw how you can use
Visual Studio Team System 2008 to help
you validate the capabilities of the soft-
ware you are building. In Part 2, I will
discuss how to ensure ongoing maintain-
ability of your code and how to measure
and communicate the level of quality in
the code you are writing.

As a developer you can use perform-
ance profiling to investigate a functional
path and learn about the performance of
the application including which methods
are called the most, which methods are
doing the most work, where most of the
CPU time was spent, etc. A performance
session can be run against the application
(Windows Forms) or against a unit test.

When running a performance profiling
session you can choose to use one of two
modes, sampling or instrumentation.

SAMPLING

Sampling is a coarse-grained perform-
ance assessment. When you use sam-
pling the performance profile will
periodically take a sample of the call
stack to find out what function is cur-
rently executing. It does this at regular
intervals (10,000 CPU clicks by default).
By doing this the performance profiler
can identify which functions were called
the most and which functions used the
most CPU time by looking at the sam-
pling results. It’s not a perfect measure –
for example, the profiler has no knowl-
edge of what is happening in between
samples taken – but it is a good way to
identify some issue and narrow down
areas to do more investigation.

INSTRUMENTATION

Instrumentation is a more fine-grained
performance assessment. With instru-
mentation a small amount of code is in-
jected into the application code at run
time. This small amount of code is used
to tell the profiler when a function is en-
tered, and when it is exited. As a result
you get an exact measurement of which
functions were using the most resources,
being called the most, and doing the
most work.

When investigating your code for per-
formance issues, it is best to start by
using sampling mode to identify problem
areas. As you narrow down to specific
parts of the application where a problem
may exist, switch to instrumentation to
get a fine level of detail.
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